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First National Bank and Trust (FNBT) offers robust fraud management and EDI solutions to protect your business. Customizable
notification emails and / or SMS text alerts allow you to accept or reject suspicious ACH and check transactions in real-time, even
before funds are removed from your account.

FNBT offers three services which are listed below. To enroll your business in any or all of these services, contact your Relationship
Manager, Cash Management Officer, or give us a call at 1-888-255-2114.

EDI TransAlert Overview

EDI TransAlert makes ACH payments a viable alternative to checks for B2B payments between companies of all sizes by translating
complex EDI 820 and 835 remittance data embedded in ACH transactions and making it usable for all sizes of businesses, whether they
use EDI systems or not.

Instead of emailing PDF reports with remittance data in “human-readable format” you will be alerted when payments containing EDI
information post to your account. You may also obtain payment information in “computer-usable formats”. View the remittance
information (including free form addenda) within the transaction history screen and/or export all remittance data to automate posting
in your accounting system. Automated delivery of posting files can also be configured.

Fraud Management — ACH Filters Overview

The Fraud Management — ACH Filters service is designed to empower business account holders (“Clients”) with the ability to prevent
financial loss due to unauthorized incoming ACH debit transactions. Certain types of fraudulent ACH debit transactions must be
returned to the originating financial institution by the opening of the 2nd business day following the settlement date. This means
businesses must identify these transactions same day and return any unauthorized transactions immediately to prevent financial loss.

Fraud Management — Check Positive Pay Overview
Fraud Management — Check Positive Pay is a service designed to empower business account holders (“Clients”) with the ability to
prevent financial loss due to check fraud.

NOTE:
All screenshots used in this User Guide were obtained while using the Chrome internet browser. If
using a different browser, certain screens may display differently than what is seen in this guide
because of the browser’s particular configuration. However, even though screens may appear slightly
different, the functionality will remain the same across all browsers.




Accessing Fraud Management / EDI Services within Business Online Banking

I. Login to Business Online Banking at www.bankatfirstnational.com or through the FNBT Business Mobile Banking App.

First National Bank
anel Trust Gompany

Lt Login: 03/08/2020
MANAGE MONEY
Account Reparting

Debit Card Management

E-Statements

o il m

Fraud Management / EDI «—

2. Once logged in, click Fraud Management / EDI from the left menu.

3. Select “Proceed” to Continue.

4.  You will be taken to the Fraud Management / EDI Dashboard for your Company. Note: depending on the Fraud Management
Services your company is enrolled in, you may see one or multiple Fraud Management modules on your Dashboard screen.

O [ o

Dashboard diReports ~ = Transaction View Change Module ~ & James Customer ~

EDI TransAlert

Total with Addenda $0.00

Credits 50.00

Debits

0000

Invalid Addenda $0.00

Fraud Management - ACH Filters

End of Day Cut-Off Time: wednesday 11:00 AM CDT

Total ACH Debits $12,382.00 o
Setto Pay $2,065.00 (2] Set to Return §10,317.00 (4]

4]

Approved List Exceptions $10,317.00

Fraud Management - Check Positive Pay

End of Day Cut-Off Time: Wednesday 11:00 AM CDT

Exceptions $0.00 (o]

Setto Pay 0.00 ©  SettoRetun 50.00 (o]



about:blank

IMPORTANT!
Accounts enrolled in Fraud Management — ACH Filters are assigned a default setting of System-
Return. If a decision is not made by the end of day cut-off time (11:00 am CT), the item will be
returned. Your default notification is an email to notify you of all debits from the account enrolled in
ACH Filters. You may also add SMS Text Notifications and change the type of notification you receive
within the Preferences menu.

Available features within Fraud Management — ACH Filters listed below:

Feature Name ' Description

Allows you to identify companies that are allowed to debit an account or accounts
and set parameters to control the debit activity.

Allows Clients to identify companies that are NOT allowed to debit an account or
accounts.

Establishes who should be alerted, how they should be alerted (email or SMS text)
and the conditions that should prompt an alert.

Approved List

Blocked List

Notification Rules

Change Transaction If the user has been granted the Change Status user privilege and the transaction is
Status eligible for a decision, you will be able to make pay/return decisions on ACH Debits.
Written Statement of | This form will be completed to return a transaction, by selecting a reason and
Unauthorized Debit providing an electronic signature authorizing the return.

(WSUD)

Allows a user to view data on the following features:
Reports = Notification Rules
= Approved List

Notification Levels

Two levels of notification and two alert types are supported, as well as customized notification rules. Approved and blocked lists are
available to automatically override the system default settings to automatically pay or return transactions when they are received from
companies identified on those lists. The approved and blocked lists are designed to minimize unnecessary alerts and action when
transactions are within pre-approved parameters.

When an account is enrolled for Fraud Management - ACH Filters, one of two levels of notification can be established for exception
alerts. The notification level options, descriptions and samples are provided below.

Notification Level Description

Transaction Alerts | One alert for each transaction.

Account Alerts One alert per account when one or more transactions are received.

businessconnection@bankatfirstnational.com
ALERT
To Chelsea Ballou
We have received one or more debit transactions to Solution Checking ending in xexx1725
Login to Fraud Management — ACH Filters to review.
Sincerely
First National Bank and Trust
Contact Us

Please do not reply to this email. If you have questions about your account, please call our Business Connection Team at (888) 255-2114 or email us at
b 1on@bankat] | com

First National Bank and Trust

345 E Grand Ave

Beloit, WI 53511




SMS Text Alert Sample

review.

Debit transactions received
for xxxx1768. Login to Fraud
Management ACH Filters to

Dashboard

Using the Dashboard

If ACH Filters are enabled, the Fraud Management — ACH Filters summary box will be displayed on the Client Dashboard. Summary
ACH transactions and status will be displayed for accounts the user has been granted access. The user
must also have the Transaction History user privilege. Active links are embedded within the boxes to permit users to navigate from the
dashboard landing page into the ACH Filters module or directly to transactions in the status selected. Dashboard totals are updated in

information on current incoming

real time as transaction status values are changed by a user.

The content displayed in the Fraud Management — ACH Filters summary boxes include the following:

Fraud Management - ACH Filters

Total ACH Debits $10,190.00 o
Set to Pay $1,440.00 [4] Set to Retumn $8,750.00 (2]
Approved List Exceptions $8,750.00 (2]

End of Day Cut-Off Time: Tuesday 11:00 AM CDT

Field Name
Service Name

Description

In the example provided, clicking Fraud Management — ACH Filters on the left in the title
bar will direct the user to the main menu.

End of Day Cut-

Displayed in the second bar, the day and time transaction decisions will be collected by

Off Time First National Bank and Trust. Transactions will be ineligible for pay or return decisions
after 11:00 am CT. If a pay or return decision has not been made, the system return
default will apply.

Total ACH In the examples above, the total represents the total dollar amount and number of

Debits incoming ACH debit transactions received by First National Bank and Trust for the

accounts the user has access to view.

Approved List
Exceptions

This represents the total dollar amount and number of incoming ACH debit transactions
received from companies that are not on the clients approved list or have violated an
approved list parameter.




Fraud Management — ACH Filters

End of Day Cut-Off Time: Tuesday 11:00 AM CDT

Total ACH Debits $10,190.00 (5]

Set to Pay $1,440.00 (4] Set to Return $8,750.00 (2]
System (0] System $8,750.00 (2]
User (0] User $0.00 (0]
Approved List $1,440.00 (4] FI $0.00 [0]
FI $0.00 (0]

Approved List Exceptions $8,750.00 [2]

Set to Pay / Clicking on the dollar amount hyperlinks on the Set to Pay or Set to Return lines will

Set to Return expand the view to display a breakdown of the total for each category. System Pay or
Return indicate transactions that will pay or return if no action is taken due to the default
status. User pay or return indicate a Client user decision has occurred. Approved List
indicates the incoming ACH debits that are from companies the client has pre-approved to
debit an account or accounts. The status for these transactions will automatically be set to
approved list pay. FI pay or return indicate an Fl decision has occurred on behalf of First
National Bank and Trust.

Transaction The user can click on the dollar amount link for any category to be directed to a filtered

History view of the Transaction History. In the examples below, the user has clicked on the dollar
value of debits under Set to Pay — System in ACH Filters and is directed to a view of
exception transactions that require decision.

Date Range

Debit Transaction History B cpreribors, 2020

Y Filters >
6 transactions totaling $10,190.00
Rows 1 -6 of 6.
Date Company Account # Amount Current Status Manage

> 09/08/2020 XYZ Company xxx1717 $350.00 Approved List Pay ® Return
> 09/08/2020 XYZ Company Xxxx1709 $8,000.00 Return - System ® Pay
> 09/08/2020 XYZ Company xxxx1696 £15.00  Approved List Pay ® Return
> 09/08/2020 ABC Company x0ox1776 $750.00  Return - System @pay
> 09/08/2020 ABC Company X00(1768 £75.00 Approved List Pay ® Return

> 09/08/2020 ABC Company 00001725 $1.000.00  Approved List Pay ® Return

From the Client Dashboard, a user can also navigate to the Fraud Management — ACH Filters Module by clicking Change Module >
Fraud Management — ACH Filters



EDI TransAlert
Fraud Management - Check Positive Pay

Fraud Management - ACH Filters

Dashboard and Additional File Loads after EOD

After the end of day cut-off time (1 1:00 am CT), all pending ACH transactions are processed and the Dashboard totals will clear out. If
additional ACH transaction files are loaded after the end of day cut-off time but prior to midnight, they will not be displayed in the
Dashboard until midnight, and will be included in the next day’s totals.

Preferences

Preferences allow Client users to bypass the system default landing page and automatically place the user within the service module and
page to perform routine functions. For instance, a user may decide they want to automatically land in the Transaction History page
when entering the system, instead of going to the Dashboard and clicking on Change Module and then Transaction History.

1. From within the Dashboard or Fraud Management — ACH Filters Module, click Your Name > Preferences.

Gsewp - = 1
= Client 3
= | Frreferences
Welcome |:¢,
Logout
Please use the above menu to select an action

2. The Preferences page appears.

Dashboard  siReports ~

Preferences
Default Pages

Default Module
-select v

Default Fraud Management - Check Positive
Pay Page

default v
Default Dashboard Page

default v
Default EDI TransAlert Page

default v
Default Fraud Management - ACH Filters Page

default v

3. Default Module gives the User the ability to choose the default landing page.

Preferences
Default Pages

Default Module

Fraud Management - ACH Filters

4. Default Fraud Management — ACH Filters allows the user to select the default landing page within ACH Filters.



Defpult Fraoud Management - ACH Filters Page

5. Once any preferences have been selected, click Save to update the settings.

Preferences

Preferences Saved

Notification Rules
=  Notification rules establish who should be alerted, how they should be alerted and the conditions that should prompt an alert.
= Notification rules can be set on an account by account basis or all accounts can be configured with the same notification rules.
=  The two notification options are email and SMS text.

IMPORTANT NOTE: By entering a cell phone number for SMS text alerts, you are opting to receive text messages.

Additional fees from your carrier may apply. To opt out, simply remove the cell phone number from the user
interface and click Save.

Setup Notification Method and Condition

1. From the Fraud Management — ACH Filters Module, click Setup > Notification Rules.

T Setup ~ +h Reports -

| Matification Rules e
Approved List
\ Block List

lease use the above menu to select an action

2. The Manage Debit Notification Rules page appears. The Selection screen is the first screen of the Notification Rules page, and will
display a list of all accounts that the user has access to.

m Contacts  Conditions Confirm

Account Selection

Select Account(s) Account(s) Selected
FFFriends - xox1111 *
FFF Payroll - xxxx2222 *
FFF Expense - xXxx3333 *
FFF ESCrow - xxxx4444 *

-

*Accounts with default Notification Rules

= Next

NOTE: All accounts with the asterisk (*) symbol have not been configured, and have the default notification rules,
set up with the notification method via email. The email will be delivered to the default notification contact established by
First National Bank and Trust at initial setup of this service, until such time the account is configured. The default notification
condition is to Notify for All ACH Debits.

3. Select the accounts to be configured and move them to the Selected Accounts box.

> and < move individual accounts between Available and Selected Accounts.
>> and << move all accounts between Available and Selected Accounts.



4. Once all accounts have been selected, click the Next button to proceed.

FE GO Contacts  Conditions  Confirm

Account Selection

Select Account(s)

FFF Payroll - :oo02222 *

FFF Expense - xxix3333 *
FFF Escrow - ooocdadd *

*Accounts with default Notification Rules

Account(s) Selected

FFFriends - 00001111 *

—

= Next

5. The Contacts screen is the second screen of the Notification Rules page. The Contact screen will allow entry of up to 6 email

addresses and up to 6 cell phone numbers.

Selection Conditions Confirm

Enter the contact information 1o receive the ALERT

Tay charge this enter contact nformation belaw,

Cell Phone 1
Cell Phone 2

Cell Phone 3

Email 1
Email 2

Emaill 3

+ Back

This account is currently st to send al naotifications on all ACH debits ta Tom Jomes {ldelasre@achalert.com).

Cell Phone Text

Cell Phone 4

Cell Phong 5

Cell Phone &

E-mail

Email 4

Emall 5

Email &

6. To add a cell phone number, enter the 10-digit cell number in the Cell Phone | field. Repeat this process to add up to five

additional cell phone numbers.

Cell Phone 1

Cell Phone 2

CellPhone 3

Cell Phone Text

(E55) 444-3333 fp— Cell Phone 4

(B18) 209-9402

¥ = -

Cell Phaone 5

Cell Phone &

7. To add an email address, enter the email address in the Email | field. Repeat this process to add up to five additional email

addresses.
E-mail
Email 1 mhart@fffriends.com e 5] 4
Email 2 fjones@fffriends.com Email 8
Email 3 | Email &

8. Once all cell phone numbers and email addresses have been added, the user can proceed to the next step by clicking the Next

button. Clicking the Next button saves the data and moves to the next step. The user can click the Back button to go back to the
Selection page, but the user will lose all data entered on this screen.

10



Selection m Conditions Confirm
Enter the contact information to receive the ALERT
This account is currently set to send all notifications on all ACH debits to Tom Jones (ldelaere@achalert.com).
To change this enter contact information below.
Cell Phone Text
Cell Phone 1 (555) 444-3333 Cell Phone 4
Cell Phone 2 (818) 203-9402 Cell Phone 5
Cell Phone 3 Cell Phone &
E-mail
Email 1 mbart@&fffriends. Email 4
Email 2 flones@fffriends.com Email 5
Email 3 Emall &
= Back  f— — =+ NENT

9. The Conditions screen is the third screen of the Notification Rules page. On this page, the user can define the criteria for when
alerts should be sent. Only one radio button can be selected.

Selection Contacts EeGLLIGLER Confirm

- Motify for all ACH Debits

Select a condition to recefve the Alert

Notify only when an ACH Debit is over
Notify only when an ACH Debit meets one or maore of the following criteria
The ACH Debit was created from a payment made by check
The ACH Debit was created from a payment over the Internet
The ACH Debit was created from a payment over the phene
Notify only when an ACH debit is received from a Company not on the Approved List or does not meet the parameters on the Approved List

+~ Back - Next

Feature Description
Notify for all ACH An alert will be sent for every ACH debit received on the accounts configured
Debits with this notification condition.

=  Enter the dollar amount.

= Alerts will only be sent when an ACH Debit is received that is greater than
the dollar amount established.

= Alerts will not be sent when an ACH Debit is received that is equal to or less
than the dollar amount established.

Notify only when an
ACH Debit is over

An alert will be sent for the criteria selected. Select one, two or all three criteria:

= Payment was made by check and converted into an ACH entry (includes
transactions with an ARC, BOC, POP, or RCK standard entry class code).

*  Payment from a bank account was authorized over the internet or on a
mobile phone (includes transactions with a WEB standard entry class code).

*  Payment from a bank account was authorized over the telephone (includes
transactions a TEL standard entry class code).

Notify only when an
ACH Debit meets one
or more of the
following criteria




Feature

Description

An alert will be sent only when an ACH debit is received on the account from a

Notify only when an company not set up on the approved list or is set up on the approved list but
ACH Debit is received violates one of the additional parameters set, such as maximum amount,
from a Company that is frequency, or start or end date.

not on the Approved
List or does not meet Alerts will NOT be sent on ACH debit transactions that are received from

the parameters on the companies set up on the approved list and are within approved list parameters.
Approved List

Those transactions will receive a status of approved list pay. However, the status
can be changed from within Transaction History.

10. Click Next to go to the Confirm page. Review all the information entered, and if correct, click the Save button. If changes need to
be made, click the Back button to navigate back to the appropriate screen.

11. Once Save has been clicked, a success message will appear.

Selection Contacts Conditions

Notification Rules have been configured successfully

12. If the default notification rules have been changed, the account will no longer have an asterisk (*).

13. If the user would like to restore the default contact and conditions, they may do so by navigating to the Contacts screen, where

there will now be an option to select a checkbox to use default contact and conditions.

Cell Phone 1

Cell Phone 2

Cell Phone 3

Email 1

Email 2

Email 3

+ Back

Selection Conditions = Confirm

Enter the contact information to receive the ALERT

Use Default Contact and Conditions

Cell Phone Text

(555) 444-3333 Cell Phone 4
(818) 209-9402 Cell Phone 5
Cell Phone 6
E-mail
mhart@fffriends.com Email 4
fiones@fffriends.com Email 5
Email 6

-+ Next

12



Transaction History
Fraud Management - ACH Filters Transaction History allows authorized users to search and view all ACH debits that have been
received on enrolled accounts, and to make decisions on items. Client users can use Transaction History to search for ACH

transactions for a specific account using one of the many filtering options available.

View Transaction History

NOTE:
Transactions are visible in transaction history for 90 days.
The Transaction History user privilege must be enabled to access this screen.

decision, the Pay and Return buttons will be available for use.

Transactions that will be paid will have green shading as a background.

Transactions that will be returned will have yellow shading as a background.

Transaction in a return status cannot be changed after the EOD cut-off time (1 1:00 am CT).

YVVYVY VVYVY

If the user has been granted the Change Status user privilege and the transaction is available to

Filters Transaction History from the Dashboard, by clicking on the dollar amount next to Total ACH Debits.

End of Day Cut-Off Time: Tuesday 11:00 AM CDT

Fraud Management - ACH Filters

Total ACH Debits $10,190.00 D — (6]
Set to Pay $1,440.00 (4] Set to Return $8,750.00 (2]
Approved List Exceptions $8,750.00 (2]

2. Another option is to navigate within the Fraud Management — ACH Filters module, to the View menu and click Transaction

History.

Fraud Management - ACH Filters ~ #5Setup~  JhReports ~ = Transaction Histary <4+— Change Module ~

Welcome

Please use the above menu to select an action

3. The Transaction History page will display all current day transactions for all accounts to which the user has access.

Debit Transaction History

T Filiers
Dare O VY Arcoant @ ATl CLeTEnT Sraus Manage
F  OB/DES20ND PlhveEna's Hdiurs bbb LR S60.00 Pary - Syutem m
¥ ORMOE203 ptarshall Moededin NN TETE $1,042.00  Pay - Sysem m
¥ ORAES200 Leningrad Livery e TG T SHEZO  Pay - System
¥ ORGS0 Kilhiry's Brafts s TETE STEEGO  Pay - Sysbem m
¥  OROEZ030 JUSARC @ i Sal wxenTETE FL00.00  Pay - System m
* SO 20000 Emcden's Ice Cre L EEE L - Tl i Retusn - Liser
¥ ORS00 FALE O HEart St s AT FAT.00  Pay - System m

Date Range
-"'.I Uit &, 2020

1. There are two ways to navigate to the Transaction History page. One option is to navigate directly to Fraud Management — ACH

13



Field Description

Date Date the ACH debit was presented for payment or loaded to Fraud Management — ACH
Filters.
Company Name of the company debiting the account. This information is obtained from the

company name field in the batch header record of the ACH transaction.

Account Number

Account number the ACH debit was presented against.

Amount

Amount of the ACH debit.

Status

Approved
List- Pay

Pay-User

Return-
System

Return-User

Change Allowed

Until

Indicates a client user has changed the status of a transaction from
Return to Pay.

Transactions that load with this status indicate the company that
originated the transaction was set up on the approved list for this
account prior to receipt of the transaction and the transaction
amount, frequency and date are within the allowable parameters
specified in the approved list entry.

Transactions that load with this status indicate the default condition
is to return all transactions on this account if client users take no
action.

Indicates a client user has changed the status of a transaction from
Pay to Return.

Return deadline, | 1:00

am CT, account type
and transaction type.

Return deadline, | 1:00
am CT, account type
and transaction type.

Up until EOD cut-off
time, | 1:00 am CT.

Up until EOD cut-off
time, 1 1:00 am CT.

Block List-

Return

Transactions that load with this status indicate the company that
originated the transaction was set up on the blocked list for this
account prior to receipt of the transaction.

Up until EOD cut-off
time, 11:00 am CT.

4. Manage — If the user has been granted the Change Status user privilege and the transaction is eligible for a decision, a Pay or Return

button will appear for use. If the transaction is not eligible for a decision, (because the return deadline or end of day cut-off time

has passed) the button will display as ineligible.

To filter the date range of items shown, click on the Date Range drop-down.

Debit Transaction History

T Filters

Date Range
Waugust 6, 2020 =
T P vy ADCOUNT @ AETeOLIN CUrPent STagus
Mivesnas Natura XA TE 5 Pay - System
arshall Modelir WONTHTE £1.04 Pay - System
grad Liver Th B4 Pay - System w

To narrow the search results, click Filters and a window containing additional search criteria will appear.

14



Debit Transaction History
T Filters

Min Amount

5

Accounts

Max Amouni

Companies

Date Range
WAugust 6. 2020~

Transaction Status

Pay

Min Amount

To search for a transaction by amount within a minimum/maximum range, type the
minimum dollar amount of the transactions into the field.

Max Amount

To search for a transaction by amount with a minimum/maximum range, type the
maximum dollar amount of the transactions into the field.

Transaction Status

See #2 in this subsection for definitions of the different transaction statuses.

Account Type an account name or the last 4 digits of the account number into the field to
view transactions for one specific account or select an account from the drop-down
menu.

Companies Enter a specific company name.

Once search criteria are selected, click Apply to narrow your search results.

Search results are displayed in pages of 25 items. If the search contains more than 25 issue items, the results will be displayed

on multiple pages. Use the navigation buttons at the top of the search results to review all results.

20 transactions totalin

:_::l WS =

Click the arrow (>) next to the Client Code to view more useful detail on each issued item. The information shown in this

drop-down is an audit history of all the activity that has occurred on the issue item.

Date Company

v 09/08/2020 XYZ Company

Account: Corporate Analysis Checking xxxx1709

Transaction ID: 565737430

Individual Name: Test Business 5

¥ 09/08/2020 ABC Company

Account: Municipal Int Checking oo
Transaction ID: 565737488

Individual Name: Test Business 3

776

Rows 1-2of 2
Account # Amount

Xxxx1709 $8.000.00

Description: Test2
Trace #: 064208470000022

Company ID: 2222

Xxxx1776 $750.00

Description: Test
Trace #: 064208470000020
Company 1D: 1111

Current Status Manage

Return - System

Add to Approved List

Deadline To Pay: Tuesday 11:00 AM CDT

Approved List Violation: Frequency: MONTHLY Last Transaction

Date: 01-SEP-20

Return - System

Add to Approved List

Deadline To Pay: Tuesday 11:00 AM CDT

15



Account

Transaction ID

The account name and last 4 digits of the account number-.

Unique ID assigned by the Fraud Management — ACH Filters system when
transactions are loaded.

Individual Name

Name of the payee/recipient found in the individual ID field of the incoming ACH
transaction.

SEC Code

Standard entry class code. Reference the NACHA Rule Book for SEC code
descriptions. SEC codes are generally used to classify transactions by the way they
were authorized.

Description

The description used by the originator of the transaction, as contained in the
company batch header record for the transaction received.

Trace # A unique ID assigned to the transaction by the originator, ACH operator or receiving
depository financial institution.

Company ID A unique identifier for the company that originated the ACH debit. This information
is obtained from the company ID field of the batch header record of the ACH
transaction. This unique identifier is used to match transactions to approved or
blocked list entries.

Add to Approved Will only appear if the user has Act on Approved list user privilege. Please refer to

List Subsection lll, Approved List within this Section for more information about this feature.

Add to Block List

Will only appear if the user has Act on Blocked list user privilege. Please refer to
Section 1V, Blocked List within this Section for more information about this feature.

Download WSUD

Deadline to
Pay/Return

Option to download a PDF copy of an electronic written statement of unauthorized
ACH Debit signed by the client user when returning an ACH debit that required the
dispute form.

Deadline to change the status of any transaction from Return to Pay.

If the user has been granted the Change Status user privilege and the transaction is eligible for a decision, a Pay or Return button

will appear for use. If the transaction is not eligible for a decision, the button will display as ineligible.
Change Status of ACH Transaction

The default status of an ACH debit transaction that is not on the ACH Approved List is Return — System. The Client can opt
to change the status to Pay if the Client determines the debit transaction should be paid.
Click the Pay button under the Manage column.

16



3.

Date

> 09/08/2020

> 09/08/2020

2> 09/08/2020

> 09/08/2020

> 09/08/2020

> 09/08/2020

Company

XYZ Company

XYZ Company

XYZ Company

ABC Company

ABC Company

ABC Company

Account #

XXxx1717

Xxxx1709

XXXX1696

X0ex1776

XXxx1768

XXxx1725

Amount

$350.00

$8.000.00

$15.00

$750.00

$75.00

$1.000.00

Current Status

Approved List Pay

Return - System

Approved List Pay

Return - System

Approved List Pay

Approved List Pay

Manage

® Return

@ Pay

® Return

© Pay

® Return

® Return

A success message will appear temporarily in the Manage column, with an option to Add to Approved List. This link will only

appear if the user has the Act on Approved List user privilege. The user can click the hyperlink embedded in that option to
proceed to Add to Approved list. If the user does not opt to Add to Approved list at this time, the option is still available

under the expanded view of this debit item.

Date

> 09/08/2020

> 09/08/2020

> 09/08/2020

> 09/08/2020

> 09/08/2020

> 09/08/2020

Company

XYZ Company

XYZ Company

XYZ Company

ABC Company

ABC Company

ABC Company

Account #

W0ox1717

01709

W0x1696

Xxxx1776

W0X1768

Wox1725

Amount

$350.00

$8,000.00

$15.00

$750.00

$75.00

$1.000.00

Current Status

Approved List Pay

Return - System

Approved List Pay

Pay - User

Approved List Pay

Approved List Pay

Manage

® Return

@ Pay

® Return

Debit will be paid.
4+ Add to Approved List

® Return

® Return

After a few moments, the Change Status button will then change to Return, and the Current Status column will update to

“Pay-User.”

Date

> 09/08/2020

> 09/08/2020

> 09/08/2020

> 09/08/2020

> 09/08/2020

> 09/08/2020

Company

XYZ Company

XYZ Company

XYZ Company

ABC Company

ABC Company

ABC Company

Account #

XXxx1717

Xxxx1709

XXxx1696

XXXX1776

Xxx1768

xxx1725

Amount

$350.00

$8,000.00

$15.00

$750.00

$75.00

$1,000.00

Current Status

Approved List Pay

Return - System

Approved List Pay

Pay - User

Approved List Pay

Approved List Pay

Manage

@ Return

@ Pay

® Return

@ Return

® Return

® Return

Return Transactions — Written Statement of Unauthorized Debit

If an ACH transaction is set to Return, a Written Statement of Unauthorized Debit pop-up screen will appear. The user will
be prompted to select a reason for the return of the transaction by clicking in one of the radio buttons by the appropriate

return reason. Once the reason has been selected, click Next to continue. Clicking Cancel will cancel the process and the user

will be returned to the Transaction History screen.
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Written Statement of Unauthorized Debit

To return this transaction you are required to complete a Written Statement of Unauthorized Debit.
This transaction is a PPD ACH debit for $800.50 to Client 3 from your account xxxx1111
A PPD (Prearranged Payment and Deposit Entry) is @ one-time or recurring debit used to transfer funds from a consumer account.
Please select the reason you are returning this transaction:
) Never Authorized to Debit Account
) Authorized ACH Debit Amount Incorrect
_) Debited Before Date Authorized
Debit Authorization was Revoked
_ 3rd Party Did Not Send Funds to Payee
Improperly reinitiated l

Depending on the return reason selected, the user may have an additional screen to provide more information about the
return reason, such as correcting the ACH Amount (example shown below), or selecting the date the debit was authorized,
etc. Once this screen has been completed, click Next to continue. Clicking Cancel will cancel the process and the user will be
returned to the Transaction History screen.

Written Statement of Unauthorized Debit

«Change Reason
Return Reason: Authorized ACH Debit Amount Incorrect

Please enter the amount you authorized:

s

The final screen within the pop-up window is the Written Statement. The content of the Written Statement will display based
on the return options valid for the transaction being disputed. The Written Statement must be completed for the transaction
to be returned. If the Written Statement is abandoned, the transaction status will remain unchanged.

Written Statement of Unauthorized Debit

« Change Reason
Return Reason: Authorized ACH Debit Amount Incorrect

I, Tom Jones, state that I am an authonized signer or have corporate authority to act on the account "FFFriends" ending mn oo 1111, 1
am returning this transaction because:

I authorized Client 3 to onginate one or more ACH entries to debut funds from an account at DeLaere B&T, but the amount debited 1s
different than the amount [ authorized to be debited. The amount I authorized 15 S800.00.

I certify that the foregoing 1s true and correct

I consent to electronically signing this form [] —

Electronic Signature

Tom Jones

Download PDF Copy

The client user must consent the Written Statement of Unauthorized Debit by electronically signing the form. The user must
click the checkbox next to the statement ““l consent to electronically signing this form.” Once the user has done so, the “e-
signature needed” button will change to a Sign button. In addition, a PDF copy of the Written Statement will download by
default. The user can opt not to download by unchecking the Download PDF Copy option. Once the screen is correct, click
Sign to proceed with the return process.
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Ap

Written Statement of Unauthorized Debit

sson

eason: Authorized ACH Debit Amount Incorrect

I, Tom Jones, state that ] am an authonzed signer or have corporate authority to act on the account "FFFriends” ending n xxxx1111. 1
am refurning this transaction because:

I authorized Client 3 to originate one or more ACH entries to debat funds from an account at DeLaere B&T, but the amount debited 15
different than the amount I authorized to be debited. The amount I authorized is S800.00.

I certify that the foregoing 15 true and correct
I consent to electronically signing this form

Electronic Signature

Tom Jones

Download PDF Copy e l

Cancel Back m

= A success message will appear, and a copy of the Written Statement will download to the user’s PC, unless the user opted
out.

Debit will be returned

WrittenStatement _....pdf

= The Change Status button will then change to Pay, and the Current Status column will update to “Return-User.

proved List

The Approved List allows Clients to identify companies that are allowed to debit an account or accounts and set parameters to
control the debit activity. There are multiple ways to populate the approved list. It can be done through the Setup > Approved List
menu option, or users can add companies to the approved list from Transaction History. It is important to note that companies
added from Transaction History will only be added to the account associated with the transaction it was added on. To allow the
company to debit other accounts, the user must edit the approved list.

Users can edit and delete companies from their approved list.

The way Fraud Management — ACH Filters identifies approved companies is by verifying the company ID ONLY in
the batch header record of the incoming ACH transaction is an exact match. If an exact match is found, if additional
parameters have been established such as maximum amount, frequency, start/end date, the values found in the ACH
batch/transaction are compared to the list to determine if an alert is required and the transaction status that should be applied at

load time.

Some examples of incoming ACH files and the data elements used for comparison against the approved list is shown below.
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Verifies Company ID

101 026013262 064208518200806095020941 = Bank & Trust FRB Atlanta
5200ashland Armament 200008 PPDPTT=st0820 200806  1064208470000031
£220260132627677677678 0000150000800008 Ashland Armament 0064208470000393
€270260132627677677678 0000030000R00008 Ashland Armaments 0064208470000354
82000000020005202652000000030000000000 D008 0E4208470000031
5200Biclab Birmingha I B00008| PPDPTT=st0805 200806  1064208470000032
£220260132627677677678 0000130000B00008 BEiolak Birmingham 0064208470000395
£270260132627677677678 0000250000B00008 Biolak Birmingham 0064208470000396
32000000020005202652000000250000000000 D008 0E4208470000032
5200Cartwright Car S 00008 PPDPTTest0806 200806  1064208470000033
£220260132627677677678 0000800000C00008 Cartwright Car Sales 0064208470000357
8200000001000260132&000000000000000000800000C00008 0E4208470000033
5200Del RAire Develop DOOO0OA PPDPTTest0804 200806  1064208470000034
€220260132627677677678 0000170000D0O0008 Del Rire Developers 00€42084700003598
€270260132627677677678 0000270000D0O0008 Del Rire Developers 00E4208470000395
82000000020005202652000000270000000000170000D00008 064208470000034
Compares against Maximum Amount Parameter

101 026013262 0642085182008060550A054101Dclacre Bank & Trust  FRB Atlanta

5200ashland Armament B00003 PPDPTTest0820 200806  1064208470000031
€220260132627677677678 0000150000400008 Ashland Armament 0064208470000393
6270260132627677677678 0000030000400008 Bshland Armaments 0064208470000394
82000000020005202652000000030000000000150000200008 064208470000031
5200Biolab Birmingha BOOOOB PPDPTTest0805 200806  1064208470000032
€220260132627677677678 0000130000B00008 Biolab Birmingham 0064208470000395
€270260132627677677678 0000250000B00008 Biolab Birmingham 0064208470000396
82000000020005202652000000250000000000130000B00008 064208470000032

Compares against Frequency and Start/End Date Parameters

101 026013262 06420851820080605502094101Delacre Bank & Trust FRB Atlanta

5200&shland Armament 200008 PPDPTTest0820 200806| 1064208470000031
€220260132627677677678 0000150000A00008 Ashland Armamer 00E4208470000353
6270260132627677677678 0000030000A00008 Zshland Armaments 0064208470000394
82000000020005202652000000030000000000150000R00008 064208470000031
5200Biolab Birmingha E000D8 PPDPTTest0805 1064208470000032
€220260132627677677678 0000130000B00008 Biclab Birmingham 0064208470000355
6270260132627677677678 0000250000B00008 Bioclak Birmingham 00642084700003596
82000000020005202652000000250000000000130000B00008 064208470000032

= |f the notification criteria is set to Notify when a debit comes in from a company not on the approved list or violates approved list

parameters, Fraud Management — ACH Filters will alert designated contacts when a debit is received from an unknown company
or from a company that is set up, but violated the parameters. If notification criteria are set to all debits, debits over a certain
amount or certain types of debits, the system will NOT alert for approved list violations. If the transaction meets approved list

criteria, it will receive a status of Approved List-Pay. If it does not, it will receive the system default status.

Add to Approved List from Setup Menu

NOTE:

Approved List user privilege required.

I. Within the Fraud Management — ACH Filters module, click Setup > Approved List.
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@setup - aliReports -

Motification Rules

| Approved List ]-l—
i

The Debit Approved List will display. Click the Create button to add an entry to the Approved List.

# Creatp i

Delete

Approved List

Compary ID £ Company Name &

B Ammasunit

Widget FI0000.00

Frequency Start Date End Duabe Edit

8 Cande

Company 1D
Max Amaunt

Start Date

Add Accounts to Approved List

FFF Escrow - xaocdddd

FFF Expefnse - a0

a Save

Company Mame
Fregquency Mo Frequency
End Date

@ Canced

Optional
or

Required

Required

Field

Name

Company
ID

Field Validated

Exact Match

Field Content

# (number sign) 0-9
, (comma)

- (dash) (space)

| (underscore)

Company (Optional
Name

Not Validated

Max: 16 Valid Characters:
A-Z

a-z

# (number sign) 0-9
, (comma)

- (dash) (space)

| (underscore)
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Field

Name

Optional
or
Required

Field Validated

Field Content

Optional The transaction Blank: Any amountis  [Valid Characters: 0-9
/Amount meets the parameters accepted and will not
when the amount the trigger an alert.
amount is less than | ¢ Zero: No amount meets
or equal to the Max the parameters and will
Amount trigger alert.
e The transaction does | ¢ Highest amount:
not meet the $99,999,999.99
parameters when the
amount is greater than
the Max Amount.
Frequency |Optional e If multiple e Daily: | business day Counter:
transactions are on a | ¢ Weekly: 7 calendar days
file, the sort order is | ¢ Bi-Weekly: 14 calendar The counter begins with the
highest to lowest days first transaction received
dollar value. e Monthly: Monthly date- after the Company and
e If the transaction with to-date /Account is added to the
the highest dollar ° Quarterly: Quarterly APPI"OVGd List regardless if
value exceeds the date-to-date the transaction meets or
Maximum Amount, all o Yearly: Yearly date- to- does not meet the
transactions on the date parameters of the APPI"OVGd
file are not approved. List.
* If the transaction with|Date-to-Date Exceptions:
the highest dollar e Non-Leap Year January
value is equal to or 29, 30, 31: February 28
less than the e Leap Year January 30, 31,
Maximum Ar'nou.nt, February 29
that transaction is e March 31: April 30
approved and all e May 31: June 30
other transactions on
e August 31: September 30
the file are not
e October 31: November
approved. 30
Start Date [Required e The transaction The Start Date is based on  |Valid Characters: 0-9
meets the parametersithe settlement date.
when the date is
equal to or after the
Start Date.
e The transaction does
not meet the
parameters when the date
is before the Start
Date.
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Optional

or Field Validated Field Content
Required
End Date |Optional

Field

Name

The transaction The End Date is based on the |Valid Characters: 0-9
meets the parametersjsettlement date.
when the date is
equal to or before
the End Date.

e The transaction does
not meet the
parameters when the
date is after the End
Date.

e The transaction
meets the parameters
when

the field is blank.

Choose from the list of available accounts to add to the Approved List.

> and < move individual accounts between list of available accounts and selected accounts.
>> and << move all accounts between the available and selected accounts fields.

Add Accounts to Appraved List

FFF Expense - nox3333 FFF Escrow - moodddd

FFF Payroll - mon2 222

FFFriends - oo 1111

= Save @ Cancel

Once the entry is completed, click Save to save it to the Approved List. A success message will appear.

Ly Approved Company Saved Successfully
+ Create
Approved List
Company ID & Company Name &
Delete Maximum Amount Frequency Start Date End Date Edit
ACME Acme Widget 06/18/2020 Edit
TIONES1 Tom Jones $50,000.00 MONTHLY 06/18/2020 Edit
¥ Delete Selected @ Cancel

To edit any entity on the Approved List, click the Edit hyperlink at the end of the appropriate row to be taken to the Company’s
screen.

To delete any entity on the Approved list, click the checkbox next to the appropriate row, and click the Delete Selected button.

23



Add to Approved List from Transaction History

NOTE:
» Transaction History user privilege required.
» Act on Approved List user privilege required.

. From the Transaction History page, click the > arrow to expand the entry of the ACH debit transaction.

Date Company Account # Amount Current Status Manage

¥ 09/09/2020 X¥Z Company o1 717 $450.00  Return - User
¥ 09/09/2020 X¥Z Company Xxx1709 $9,000.00  Return - System
v (09/09/2020 X¥Z Company X000 696 $17.00  Return - System

Account: Business Interest Checking xox1696 SEC Code: PPD Add 1o Approved List
Transaction ID: 565746972 Description: Test2 .
Deadline To Pay: Wednesday 11:00 AM CDT
Individual Name: Test Business 4 Trace #: 064208470000021 . . . . .
Approved List Violation: Transaction Amount: 17 is greater than
Cormpany ID: 2222 Approved List amount: 15

2. Click the Add to Approved List button to add a company. The Add Company pop-up window will appear.

Add Company to Approved List

Company Id Company Name Start Date End Date
A Marshall Modelin = 08/06/2020 =

Max Amount Frequency
1042 none - v

Can Be

Description

Populated with the company ID data from the batch header record
of the transaction received.

Company ID

Modified

Populated with the company name data from the batch header

Company Name . .
pany record of the transaction received.

|
Max Amount Populated with amount of transaction received. ™
Frequency Left blank. ™
Start Date Populated with the date of transaction received. ™
End Date Left blank ™

3. Click the Save button to add to Approved List. Click Cancel to return to the Transaction History without adding to the Approved

List.

The user will be directed to the Transaction History page once the company has been added to the Approved List.
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When a transaction exception is triggered because of Approved List parameters, the system default status will apply. Examples of types
of failure reasons are listed below.

T

/Amount is Greater than the maximum amount in the Approved| cyrent Status Manage
than Approved List[List entry.

ransaction Dollar amount of transaction is greater

Add to Approved List Add to Block List

Deadline To Return: 08/16/2020 5:00 PM EDT

Approved List Violation: Transaction Amount: 1500 is greater than Approved
List amount: 1000

Frequency Failure [Transaction violates the frequency set in

the Approved List entry.
Add to Approved List Add to Block List

Deadline To Return: 10/03/2020 4:00 PM EDT

Approved List Violation: Frequency: YEARLY Last Transaction Date:

06-AUG-20
Out of Date Range [Transaction was presented prior to the
Start Date or after the Ending Date of the
Approved List entry.

Add to Approved List Add to Block List

Deadline To Return: 08/13/2020 5:00 PM EDT

Approved List Violation: Out of Date range - Start Date: 18-JUN-20 End Date:

ocked List

The Blocked List is an optional feature which allows Clients to identify companies that are NOT allowed to debit an account or
accounts. There are multiple ways to populate the blocked list. It can be done through the Setup > Blocked List menu option, or
users can add companies to the blocked list from Transaction History. It is important to note that companies added from
Transaction History will only be added to the account associated with the transaction it was added on. To prevent the company
from debiting other accounts, the user must edit the blocked list.

Users can edit and delete companies from their blocked list.

If an exact match is found, if additional parameters have been established such as maximum amount, frequency, start/end date, the
values found in the ACH batch/transaction are compared to the list to determine if an alert is required and the transaction status
that should be applied at load time.

The data elements used for comparison against the blocked list are the same as those used for the Approved List. See Approved
List section above.

Blocks are intended to automatically return items and alerts are not sent out. However, Clients can see those items in transaction
history and have the option to pay them before EOD cut-off time. The dashboard will be updated in the next release to display
blocked item summary information.

Adding Companies to the Block List is similar to adding Companies to the Approved List. See Approved List section above for
details.
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Fraud Management - Check Positive Pay

Notification Alerts

Check Positive Pay is designed to ensure notifications are relevant. You may choose to receive email and / or SMS Text alerts.

Type of Alerts
e Exception Alert - Occurs when a check is presented for payment that does not match the issue information.
¢ Issuance File Load Alert - Occurs when an issue file is loaded. The alert contains status information to indicate if the issue
item loaded properly or if the issue item failed due to errors.

Notification Levels

e Transaction Alerts — Separate alerts for each exception identified
e Account Alerts — One alert per account when one or more exceptions are identified

Sample Email Alert

BusinessConnection@bankatfirstnational.com Thu 4:21 PM
Check ALERT

o Click here to download pictures. To help protect your privacy, Outlook prevented automatic download of some pictures in this
message.
‘We have recerved one or more checks to Solution Checking ending in xxxx1725.
Login to Fraud Management — Check Positive Pay to review.
Sincerely
First National Bank and Trust
Contact Us

Please do not reply to this email. If you have questions about your account, please call our Business
Connection Team at (888) 255-2114 or email us at BusinessConnection@bankatfirstnational com.

First National Bank and Trust
345 E Grand Ave

Beloit, WI 53511

Sample Text Alert

Checks received for
XXXX1725.

Login to Fraud Management
Check Positive Pay to
review.

Using the Fraud Management — Check Positive Pay Dashboard

Summary information on current check transactions and status will be displayed for accounts the user has been granted
access. Active links are embedded within the Check Positive Pay box to allow users to navigate from the dashboard landing
page into the Check Positive Pay service module or directly to transactions in the status selected. Dashboard totals are
updated in real time as transaction status values are changed by a user.
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Fraud Managemaent - Check Positive Pay

End of Day Cut-Off Time: Wednesday 11:00 AM CDT

Exceptions $0.00 0

Serto Pay 5 O Set 1 Return 5 0O

=

End of Day Cut-Off Time — The end of day cut-off time is 11:00 am CT. This time of day indicates when transactions that require
decisions will no longer be eligible for user decisions. This is a hard cut-off time (system generated) and decisions cannot be
changed after this time.

Exceptions - Clicking on the dollar amount hyperlink on the Exceptions line will direct the user to a filtered view of Transaction
History that will display only exceptions that require a decision.

Exceptions 34

ecoe

Pay / Return an Item

Clicking on the dollar amount hyperlinks on the Set to Pay or Set to Return lines will expand the view to display a breakdown of the
total for each category. System Return indicates transactions that will return if no action is taken due to the default status. User pay or
return indicate a Client user decision has occurred. Fl pay or return indicate an Fl decision has occurred on behalf of the client. FNBT’s
default decision is System Return. To change the system default to Pay, the user will log in to Business Online prior to the |1:00 am
cut-off time and change the decision to Pay.

The status of exception items will be ‘Return — System’. If you would like to ‘Pay’ the item, simply select the blue ‘Pay’ button next to
the transaction.

Managing Issue Items

With Check Positive Pay, you may maintain a list of issued items for FNBT to compare presented items against so exceptions can be
identified. While issue items can be added after a check has been presented for payment, it is highly recommended that Clients enter or
load issue items prior to disbursing paper checks to payees, as failure to do so could result in denial of payment if the check is
presented at the teller line for deposit or to be cashed. If issue items are entered or loaded on accounts configured for positive pay
types that don’t require a list, Check Positive Pay will ignore them. When an issued item is entered or loaded into Check Positive Pay,
the status and disposition of the issued item is tracked. The table below describes the status and disposition labels associated with issue
item management.

. — A status defined by the Client that indicates a check was issued

. — A status defined by a Client that a check was issued but later voided and not distributed.

. - A status assigned by the Check Positive Pay system when an issue item is entered or loaded by a
Client.

. - A status assigned by the Check Positive Pay system when a check is presented for payment with a serial

number that matches a serial number for an issued item.

. - A status displayed in the issue warehouse that indicates a check has not yet been presented for the issued item
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and it is still available for matching.

. - A status displayed in the issue warehouse that indicates a check has been presented against an issue item and it was paid
by the system, Client user or Fl.

- A status displayed in the issue warehouse that indicates a check has been presented against an issue item and it was
returned by the system, Client user or Fl.

- A status assigned by the Check Positive Pay system when an issue item that has not been used in Matching

(outstanding) has been removed from the system.

- If an issue item is updated after it was loaded, history will be available in the issue item warehouse when the drop

down for an issue item is expanded.

Status of ltems
Issued items can have a status of Issued or Voided.

e Issued - The check has been issued and distributed for payment.
e Voided - The check has been voided by the maker. A check is usually voided prior to disbursement. A voided check cannot be
used to make a payment or withdraw money from the account.

Manually Enter Issue Items
Clients can manually enter a list of checks that have been issued. To manually enter an issue item, the user must be granted the manual
issue entry user privilege. The table below describes a list of fields that may be displayed in the manual entry screen, the criteria for the
field to display and how the information entered will be used to identify exceptions when matching issue items to checks presented for

payment.
Field Criteria Use
Serial # The check number/serial # is always required. pr‘f:g:ﬁ”:ﬂiiﬁf;“gfg“m
Amount A dollar value is always required. Used to identify if the amount of a

check has been altered.

Payee Name

The person(s) or entities to whom the check was intended to
pay. The field will support entry of multiple payee names
(maximum of 4 allowed) by clicking “Enter” to input another
name on the next line.

This feature is optional, and the field will only appear for
accounts configured for payee positive pay.

Used to identify if the name in the
“Pay to the order of” line has been
altered.

Status

Each check should be accounted for, even checks that have
been voided. The status value advises the Fl if a check has
been issued and distributed, issued, later voided and not
distributed or issued. The issued and void status values will
always be available for selection.

Used to determine if a check should
be analyzed for matching (issued)
or if a check was presented for
payment that was previously
voided.

Issuance Date

A date the check was issued and valid for payment is always
required. The issuance date will always default to the current
date, but the user can assign a back or future date.

Used to determine if a check is
presented earlier than intended or
later than allowed.

I.  From the Fraud Management — Check Positive Pay module, click Perform > Manual Issue Entry.

AT ] o
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2. The Manual Issue File Entry screen appears.

Manual Issue Entry

Acoount’ Busbo populate next check number: 5

Ao Serial Mumber Amaunt Payee Name Status Issuance Cate

0 Click sy row to select that row for editing

3. Enter data into each field:

e Account - Select appropriate Account Number from the drop-down menu.

e  Auto populate next check number - When checked, the next check number will auto-populate in the following row. This
feature is designed to eliminate serial number entry when checks are issued in sequential order. When unchecked, the next
check number will remain blank until it is filled in by the user.

e Row - Each issue item will be numbered in the order they are entered. Once the cursor is placed in the current row, an
additional row will appear for the next entry.

e  Serial Number - Type the item serial number for this manual issuance file in the Serial Number field.

e Amount - Type the dollar amount for this manual issuance file in the Amount field. Or use the up and down arrows in the
Amount field to select a dollar amount.

e Payee Name - Type the payee name for this manual issuance file in the Payee Name field.

e Status:

o Issued - The check has been issued.
o Voided - The check has been voided by the maker.
e Issuance Date - Click on the Issuance Date field and select a date from the calendar that this item was issued.

4. To edit any row, click in the fields to be edited and make changes.
5. When all manual issuance items have been entered, click the Save button.
6. The Manual Issuance File Status detail page appears.

Queusd Pracessin Processed Approrved Complete

[}

Arcount Nusmber Serial Number  Amaourtt Payes Name Status Load Date Essuarce Date
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Issue Templates

The purpose of issue templates is to make it easy to load issue items into Fraud Management — Check Positive Pay using files that can
be generated out of most accounting systems. This option provides organizations a variety of flexible options for providing a list of
checks that have been issued or voided. Issue templates allow users to select from a list of file formats supported and identify where
the required data elements are located within the file.

Once a template has been set up, the template can be selected when loading a file to tell Check Positive Pay how to utilize the data
contained in the file.

Multiple file templates can be set up, displayed and used. If you currently use the standard FNBT template to upload issue items, you
will select the “FNBT Standard Template” from the import template drop down.

I. From within the Fraud Management — Check Positive Pay module, click Manage > Issue Templates

B Manage - # Perform = sh Reports = i Wiew -
[55ue Templates et

Additional Eoue Felds

vvermome

A screen will appear that lists any existing templates that are available for view or edit, and a button to Create New Template.
NOTE: Templates created by FNBT cannot be modified by a Client. Templates created by the Client can be modified by the
Client and FNBT.

e e
Client Code Cliert Mame Template File Type
Dalete  Filter by Client Code Filter by Client Hame Filter by Tem plate Filter by File Type Edit/View
v Comma Separatad &
DEFI Fixed Width Fieed Width &
Exczl 97-20032 Worlkbook Exicel 97-2003 Workibook Vs
3 Clienc3 Exce| Workbook Excel Workibook Vi
o3 Cllent 3 Exicel Workboox 2 Excel Workioook #
Delete Seleced

2. To view or edit an existing template, click the pencil icon for the appropriate template.

3. To delete an existing template, click the checkbox next to the Templates to be deleted and click Delete Selected. Templates that
have the Delete option were built by the Client and can be deleted/edited by the Client user. Templates without the Delete option
were built by the Fl and can’t be deleted/edited by the Client user.

4. To create a new template, click the Create New Template button.

Create New Template

Template Name File Type’ Template Status
- select file type v Active v

Number of Header Rows’ Number of Footer rows’ Template Level”
0 o] Client v

Multi-Line Payee Name Separator: ’
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The upper portion of the template screen will not change, regardless of the file type selected. The template name, file type and
template status values are required. The header and footer fields are optional. Many accounting systems can export excel or fixed
width files. Sometimes those files have header (beginning) rows or footer (ending) rows that contain data that is not required by Check
Positive Pay.

When setting up a template, the Client can define the number of rows the system should ignore at the beginning and end of the file. It
is important to note that if the values are entered incorrectly, an issue file may load with errors or no items.

The mapping section below will display based on the file type selected.

Create New Template
Template Name File Type’ Template Status
v ~
Number of Header Rows’ Number of Footer rows’ Template Level’
~
Multi-Line Payee Name Separator: v
Add Input Field’ File Column’ Field Format
10er
AMmou 0}
234
a Status SSUED

Issuance Date

Payee Name’

Fixed Width files will require the Client to define the start and end position in which the data element is located.

The mapping section on the lower part of the screen displays the required fields. The Check Serial # and Amount fields are always
required. You must specify if the amount data in the file to be imported will or will not contain decimal points. For example, if the
Amount value is set to Fractional Dollars, then 100, 100.0 and 100.00 are all processed the same. If the Amount value is set to Whole
numbers of cents, the system will divide by 100 and save it as a dollar value. For example, a value of 100 would be saved as $1.00 in the
system.

You may choose to import additional data by checking the Add box next to the desired data element.

If the Status box is not checked, system will load all issue items with a status of Issued. If the Client file represents Voided items as a
negative number, the Client can check the box Treat Negative Amount as Void and the system will status any item in the file with a
negative value as Voided.
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Create New Template

Template Name

Number of Header Rows’

[

File Mapping
Add Input Field’

Serial Number

Amount’
O status?
(] Account Number’

File Type” Template Status

Excel Workbook v Aclive b
Number of Footer rows’ Template Level’

0 Cliznt ~

Mulri-Line Payee Name Separator:’

File Column’

Field Format

@® Fractional Dollars (12.34)
) Whole numbers of cents (1224)

Treat Negathie Amount As void?

I

If the Client checks the Status box additional fields will display as shown below.
with an Issued and Voided status, no additional action is required.

If the Client’s accounting system exports issue items

o T T
ISSUED or ISSUED

VOIDED . for VOIDED

If the accounting system used exports issued items with a value of X and voided items with a value of Y, the user can identify the values
as shown below so the system can translate the data appropriately when importing the data.

v Status

- for ISSUED

- for VOIDED

A description has been provided below to define system behavior if additional data elements are included.

Account # If the account box is selected, the user can import one file that contains issue items for
multiple accounts. If the account box is NOT selected, when a Client user loads a file through the
Client portal, the system will require the user to select the account the checks were issued on.

Issuance Date If the issuance date box is NOT checked, the system will default the issue date to date the file was
loaded. If the issuance date box is checked, the file must contain an issuance date for each item. For
Excel files, the system will translate the data format used in the file. For separated and fixed width
files, the Client must define the date format being used as shown in the screenshot below. It is
important to note that the formats displayed are examples only, a complete list of date formats can
be found at:
https://docs.oracle.com/javase/8/docs/api/java/time/format/DateTimeFormatter.html#patterns

32




’ Issuance Date’

M for month. d for day of month, y for year

Examples
yyyy-MM-dd for 2019-12-25
MM/dd/yy for 12/25/19

MMM dd, yyyy for Dec 25, 2019

Payee Name The Payee Name box will only appear if one or more accounts are configured for payee
positive pay. If the payee name box is checked, the system will require the payee name for
accounts configured for payee positive pay. If payee name is provided for accounts not
enrolled in payee positive pay, the payee name data will be ignored when the file is loaded. For
Excel or delimited files, the complete and single payee name is expected in a single column.
For fixed width files, the complete and single payee name must be contained in the file
between the starting and ending position.

Loading Issue Files

The system allows Client users to load issue files into the system for use in matching. The system accepts these files in a variety of
formats, used in conjunction with file templates (covered in the previous section).

|. From the Fraud Management — Check Positive Pay module, click Perform > Issue File Load.

£ Manane - & Barfarm = il REpors - B VEn - Change Moduls -

[s5ue File Loed +—
MaruE| 1SEUE Entry

Welcc ACTivE Reconcilagon

Plaase use the above menu to select an action

2. The Load Check Issuance File page appears

Issue File Load

Template to Use With Issue File

- select tamplate - - Create New Template

Select template that matches issue file farmat

3. Select the Template drop-down box to select from a list of existing templates. Select one of the available templates listed. If you use
the standard template from FNBT, select the FNBT Standard Template from the drop-down. If you have a custom template, select it
from the drop down.

4. If the template selected was created without the Account field enabled, then a drop-down box will display so that an Account can be
selected. Select from the list of accounts.

[ssue File Load

Template to Use With Issue File Account?

Excel Workbook 2 A - not selected - hd Create New Template

- not selected -

FFF Escrow - xoemdd44
FFF Expense - 3333

2937

view selactad Tamplata
FFF Payroll - 0002222
Select account and template that matches issue file format| FFFriends - xow1 111

5. The file upload interface will appear. Click the Browse button to select the appropriate file.
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Issue File Load

Template to Use With Issue File Agcount’

Excel Warknonk v FEFriends - o1 111 v Create New Template

View Selected Template

Select one issue file that i in the format of the szlected template

el m

6. Once the file is selected, it will be displayed in the upload interface.

Issue File Load

TE'H'IPHTE o Lise With [5s0e File Account”

Excel Workhook 2 w FFFriends - ;oo 111 ~ Create Mew Template

View Selemed Templats

Select one issue file that is in the format of the selected template

b

kezue £523-001 i

) B & @
B Issue 0529001 sk : @ kemove | @ Upload m
Remove The file will be removed from the page.
Browse Click Browse to add more Issuance Files to upload.
Upload The file will be uploaded.

7. The Status Bar will display the current status of the file.

= Back to S1aTUs Issue 0228 _1.xlsx

Fil= Status

Quevs=d Prooessing Process=d Approved Complete

Filz is processing . ..

Dieleted
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8. If errors were encountered during the initial processing of the issuance file, the Parse Errors display will appear, allowing the user to
view the error detail within the file. The most common reason this error would appear is because the file contains improper
formatting. At this point, the user will have the option to:

» Correct those errors.

» Delete individual errors. This feature only displays if there are errors in the file and is only available until errors have been
corrected and the file is saved.

» Delete all errors. This feature only displays if there are errors in the file and is only available until errors have been corrected
and the file is saved.

o This will retain the totals and counts for audit history.

» Discard the file. This feature shows up when there is an error in the file. This option is not available after corrections have

been made and saved.

This will remove the file and its contents from the system

File Status

@

Line
Poumber Becour sartal Numbar Amaunt Payee Name Tmmuance Date Dulete

SA53S Ciseo e by, LLT

S60000 lanatran C

I §260.00 of

255 553300 waller Lansden Dart

8 Click sy row o select that row For editing

In this case, the account numbers in the issuance file were entered incorrectly and they need to be corrected before the file can be fully
processed and loaded.

> Click on any of the fields highlighted in red to make updates or changes
& Edit 9 Errors | Dol Al Crror |
Raows 1 -8 of9,
Lime
Number ACcount Serial Number Amount Payee Name’ Issuance Date Delere
5555555555 3255 65.55 Cisco Webew, LT 2020-05-26
e s aco T | OF5g £ £5.55 =
1 z¢l=ct acoount =3 e ! s Cisco Wabex, LLC ~ i
Wl -WANN222E
3 a333 9338 560000 Jenathan Copeland 05/28/2020 it

In this example, the user is presented with an account number drop-down so they can choose the correct account number for the
issuance item.
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Once all errors have been corrected, the red highlights are no longer visible, and the file can be reprocessed by clicking the Save and

Submit button. This feature is only available until all errors are corrected, deleted or discarded.

@ Edit 5 Emors
aws 1- %ol 9
Lime .
MNumber Account serial Number Amaount Fayes Mame’ Issuance Date Deleta
4 FAFriends - o111 9155 565.55 Gieco Wyebex, LLC 05383020 o
5 FRFriends - waoned 111 G256 S600.00 Jonathan Copreland (5 2802020 i
B FAFriends - xaoxi111 9257 F260.00 QITice Fride OS¢ 262020 o
7 FEFriends - a1 111 9256 1 Richard Canowa 05/ 28/ 2020 o
B FAFriends - 1111 9159 F933.00 fialler Lansden Dortch & Davis, U5/Z8/2020 i
LLP
G Frriends ettt ] 1 Riermars-Gann =i e
10 FRFriends - o111 9267 553.36 Richard Canova OS5/ 282020 o
1 FRFriends - waonet 111 G161 52400 Advanced Medical Inc. (5 282020 i
12 FAFriends - o111 9163 56,130.00 Ciizens Lnlon Bans () OS5/ Z82020 i
& Click ary row to select that row for :diting l
Save pnd Submit
The file will be returned to processing.
< Backto Status 5V Issue 0228 S.cev
Fila Status
Queved Processing Processed Approved Complete Deleted
File is processing . ..

If the file processes successfully, the user will be able to view the details on all the items in the file.
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Account Number  Serial Number  Amount Payee Name Status Load Date Issuance Date

If there are no errors in the file during the initial load, then the file will automatically display as approved and complete.

Payee name scoring is robust and can reasonably handle a variety of check styles, fonts and even handwritten names on a payee line
with fewer exceptions. To achieve optimal results for payee positive pay, we recommend you follow as many of the best practices
outlined below as possible:

> Paper weight should be 24th MICRBond (to ensure better image quality when physically captured with reader).
> Use check stock with no backgrounds or lighter colored backgrounds and no logos or marks in the payee field.
> Minimum 200 dpi resolution required; higher resolution preferred.

> Checks should be printed using a laser or ink jet printer using black ink.

> Fonts should be fixed width (fixed spacing) |10-point font or higher.

> Sans Serif fonts are preferred (no bold).

> “PAY TO THE ORDER OF” should not be italicized or underlined and must be printed horizontally at the same level to the left of

the payee name.
> Payee name should be a maximum of 100 characters and left aligned.
> The payee name should be surrounded by an area of white space.

> Payee name should not be underlined.

37



EDI TransAlert
Dashboard
The Dashboard is a quick reference summary of the current day's file information.

* Direct links will navigate the User to specific transactions:
=  Total with Addenda

= Credits
= Debits
= Total without Addenda (Only displays if Fl opts to display all ACH Transactions)
= Credits
= Debits

EDI TransAlert

Total with Addenda $0.00 ©  Total without Addenda $0.00 (0]
Credits $0.00 (0] Credits $0.00 (0]
Dehits $0.00 (0] Debits $0.00 (0]
Invalid Addenda $0.00 (0]
Viewing the Dashboard
NOTE:

The Transaction History user privilege must be enabled to view transactions. To view addenda
information the following privileges must be enabled: 820 Remittance Report, 835 Healthcare
Report and/or Free Form Addenda Report.

Direct Links to Specific Transactions

Total with Addenda
All ACH transactions with addenda information will be displayed.

Transaction History Eate Range
@EMarch 29, 2019~
Y Filters >
Rows 1 - 18 of 18.
ID4: Account Account Name Originating Company Credit Debit Settlement Date View
> 974 201555 ABC Heating CAT HC PDX TEST $300.00 03/29/2019 >
> 973 KXXX2345 Billy's Towing CAT HC PDX TEST $200.00 03/29/2019 L)
> 972 HWXxN1525 Bob's Grocery CAT HC PDX TEST $100.00 03/29/2019 =
> 91 HXXX1555 ABC Heating CAT CTX PDX TEST $16,122.80 03/29/2019 L
> 970 XXXX2345 Billy's Towing CAT CTX PDX TEST $40,559.00 03/29/2019 =
> 962 HXxx1525 Bob's Grocery CAT CTX PDX TEST %$3,555.00 03/29/2019 R
> 968 XXXX1555 ABC Heating CAT FF PDX TEST $40.00 03/29/2019
> 967 202345 Billy's Towing CAT FF PDX TEST $60.00 03/29/2019

= 835-Healthcare — ACH transactions containing 835 Healthcare addenda records
= 820-Remittance — ACH transactions containing 820 Remittance addenda records
*  Free Form — ACH transactions containing Free Form addenda records
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EDI TransAlert

Total with Addenda $0.00 ©  Total without Addenda $0.00 [0}
Credits $0.00 [o] Credits $0.00 [o]
835-Healthcare $0.00 (0]
820-Remittance $0.00 (0]
Free Form $0.00 (0]
Debits $0.00 (0] Debits $0.00 (0]
835-Healthcare $0.00 (0]
820-Remittance $0.00 (0]
Free Form $0.00 (0]
Tnvalid Addenda $0.00 (0]
835-Healthcare $0.00 (0]
820-Remittance $0.00 o
Total without Addenda
All ACH transactions that do not contain addenda information will be displayed.
Transaction History Eate Senge
EMarch 29, 2019+
Y Filters >
Rows 1-60f6.
IDIA Account Account Name Originating Company Credit Debit Settlement Date View
» 968 X00K1555 ABC Heating CAT FF PDX TEST $40.00 03/29/2019
» 967 002345 Billy's Towing CAT FF PDX TEST $60.00 03/29/2019
¥ 966 XXXX1525 Bob's Grocery CAT FF PDX TEST $50.00 03/29/2019
» 861 X0x1555 ABC Heating CAT FF PDX TEST $40.00 03/29/2019
» 860 XX3X2345 Billy's Towing CAT FF PDX TEST $60.00 03/29/2019
» 859 %001525 Bob's Grocery CAT FF PDX TEST $50.00 03/29/2019
Preferences

I. Click on the user's name to open the Preferences page.

Change Module -

& vivian Kortman -

2 DDG Daycare

A Preferences
O Logout

2. Default Pages gives the user the ability to choose the default landing page.

3. Default EDI TransAlert Page allows the user to select the default landing page within EDI TransAlert.
=  Manage/EDI Export
*  Transaction History
=  View/Export Status
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Default EDI TransAlert Page

Oeld
Manage / EDI Export
Transaction History
View / Export Status

Alert Notifications
Alert Notifications per Transaction

Text Message
=  Sample Text Message Alert

NOTE:

} Alert email and text messages will be sent to the Contact(s) for every transaction in the file.

Email Message
=  Sample Email Alert

You have received a transaction
with EDI information on
account ending in xxxx6666
from PDX TEST CLIENT. Login
to review.

EDI Export

Generating Reports

I.  Switch to the EDI TransAlert Module by clicking on EDI TransAlert on the Dashboard or from the Change Module
dropdown menu.

EDI TransAlert

Total with Addenda $0.00 ©  Total without Addenda $0.00 o]
credits $0.00 0 credis $0.00 0
835-Healihcare s [o]
820-Remittance $0.00 (o]
Free Form $0.00 2]
Debits (o] Debits $ (0]
835 Healthcare i [ o]
820-Remittance [o]
Free Form $0.00 (o]
Tnwalid Addenda $0.00 (o]
835 Healthcare E o
820-Reminance o

L rarage Micdulr -

ELT Trancidr-i
Frad Klamage ez - Tnack Poatien Py
Fraesd Mlgsagemens - AIH Filers

2. Click Manage> EDI Export.



EDI TransAlert £ Manage - i= Transaction History h View ~

EDI Export

3. Using the dropdown menus, select the desired report information and click Generate. Once the report has finished
generating, click Download to view/save the report. To generate another report, click Start Over to repeat the process.

Report Type Template Account’ Settlement Date

x12 820 EDI v - select template - v - notselected - e & | 03/01/2019

Leave unselecred 1o generate report for all

accounts

Your report Is being generated...

Page will update when finished.

Report complete:

Start Over

Option Description

= X12 820 EDI
Report Type = X12 835 EDI

" Free Form

= 820 File per Transaction, 820 PDF, Default 820 CSV, Raw 820 Text File, 820 Extended
PDF, CCD+ 820

T lat 835 File per Transaction, 835 PDF, Default 835 CSV, Raw 835 Text File, 835 Extended
empiate PDF, CCD+ 835

® Free Form File per Transaction, Free Form PDF, Free Form Raw Text File, Free
®* Form Extended PDF
= | eave blank to include all accounts

Account .
= Select specific account from dropdown menu

Settlement Date = Click in box to select settlement date from calendar

Report Examples

. XI12 820, X12 835 & Free Form File per Transaction



| 0O0_10001555 _EDI_Data_654_2019-05-22 0 SR 53AM  Tett Document
| 0O1_10002345  _EDI_Data_656_2019-05-22.0 5/22/2019953AM  Text Document
] 0001_10002345  _EDI_Data_658_2019-05-22.0 §/22/2019 953

Tent Do urmient

- .
m

-
m

2. XIl2 820 PDF

3.

4.

820 Remittance Advice Report
Generated Mar 1, 2019 8:15:12 AM
[ [ | S8 | St S e s (50| v
o | woossss | POKTEST w0 creon | waraons foesaseses | 2| ssssoo oo
X12 820 Extended PDF
Remittance Advice Report CAT CTX POX
TEST 191010
. ACH Information 255076920009624
Receiver Name: . . CTX
Settlement Date Orlgln.ator Name:
Effective Entry Date: CTX
Trace Number:
OFI Account Number: SEC Code:
Amount: Bob's Grocery
Transaction Type: OctID, 2019 Transaction Description:
1(3)0(5);2280 Remittance Information
Seller's Invoice Number 3 :
Amount Paid $3,555.00
Invoice Amount $0.00
Amount of Discount 045454545 $0.00
X12 820 Default CSV
4| B c D E F G H | J K 5 M N 0 P Q
Receiver Receiver Originator  Originator Entry Transaction Debit or Settlement Trace Ac Reference Amount Invoice Amount of Invoice
17 Name Account # Name ] Description Amount Credit Date Number Requested D& Code Paid Amount Discount  Adjustments Date
& 'Bil!y‘s Towi XXxxx22222 CATCTX PDX~ 5.56E+09 CTX 40500 Debit 7/30/2019 6.4208E+13 0 Q4545454522 40558 (1] o 0
3 |ABC Heatin| XXXXXS 5555 CAT CTX POX 5.56E409 CTX 16000 Credit 7/30/2019  6.4208E413 0 Q3737373722 16122.8 0 0 0
12 CCD+ 820
5200CAT CTX PDX TEST 5555555555CTXCTX 1591010 1255076920000001
62225507692810001525 000035550065651651 Bob's Grocery 1255076920009624
ISA*00* 00~ *ZZ*CAT TREE STAND *ZZ*Comet Street, L*181228*104
6*U*00400%*014444444*0*P*~\GS*RA*CAT TREE STAND*Comet Street, L*20181228*1046*144
28650*X*004010\ST*820*0001\BPR*C*3555.00*D*ACH*CTX*****%4343434343\TRN*1*00200001
G6S\ENT*1\RMR*ZZ*Q45454545**3555.00\REF*L1**1151515151 454545-01\SE*7*0001\GE*1*1
4444444\IEA*1%014444444\
62225507692810001555 00016122006841654 ABC Heating 1255076920009626
ISA*00~ *Q0o* *ZZ*DOGGY-DOGS TOYS*ZZ*KITTY COMPANYS *181231*104
4*U*00400*64649649646*0*P*~\GS*RA*DOGGY-DOGS TOYS*KITTY COMPANYS*20181231*1044*644
555555*X*004010\ST*820*0001\BPR*C*16122.80*D*ACH*CTX*****5858585858\TRN*1*002000
1523\ENT*1\RMR*ZZ*Q37373737**16122.80\REF*L1**1 959595959 373737-01 KITTY COMPAN
Y5 - Staff\SE*7*0001\GE*1*644444444\IEA*1*644444444\
62225507692810001525 000035550065651651 Bob's Grocery 1255076920009644
ISA*00* *00* *ZZ*CAT TREE STAND *ZZ*Comet Street, L*181228*104
6*U*00400*0144444944*0*P*~\GS*RA*CAT TREE STAND*Comet Street, L*20181228*1046*144
28650*X*004010\ST*820*0001\BPR*C*3555.00*D*ACH*CTX*****4343434343\TRN*1%00200001
6S\ENT*1\RMR*ZZ*Q45454545**3555.00\REF*L1**1151515151 454545-01\SE*7*0001\GE*1*1
4444444\IEA*1%014444444\
€2225507692810001555 00016122006841654 ABC Heating 1255076920009€646
ISA*00* *00* *ZZ*DOGGY-DOGS TOYS*ZZ*KITTY COMPANYS *181231*104
4*U*00400* 64649649646 0*P*~\GS*RA*DOGGY-DOGS TOYS*KITTY COMPANYS*20181231*1044%644
555555*X*004010\ST*820*0001\BPR*C*16122,.80*D*ACH*CTX*****5858585858\TRN*1*002000
1523\ENT*1\RMR*ZZ*Q37373737**16122.80\REF*L1**] 955595959 373737-01 KITTY COMPAN
YS - Staff\SE*7*0001\GE*1*644444444\IEA*1"644444444\
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6.

7.

8.

X12 820 Raw Text File

1] EDI_Data_180_2019-03-0Ltxt - Notepad
File Edit Format \View Help
EKSM‘OO‘ *00* *ZZ"CAT TREE STAND “ZZ*Comet Street, L*181228*1046*U*00400%014444444%0"P*~\GS*RA"CAT TREE

STAND*Comet Street,
L*20181228%1046%14428650*X*004010",5T*820*0001 \BPR*C*3555. 00*D*ACH*CTX* “** %434 343434 3\ TRN*1*0020000165\ENT*1\RMR*ZZ*Q4 54 5454 5%%355
5. 00\REF*L1**1151515151 454545-01\SE*7*0001\GE*1*14444444 \TEA*1"014444444"

X12 835 PDF
CCD+ Healthcare Payment Report
Generated Mar 1, 2019 8:24:20 AM
Account | Account | originator [ Reassociation  |Originating Reference
Mg Numb e l Amount Debit / Credit | Settlement Date Nombar Company ID Masmm
Account 1 PDXTEST i ! ! | 1232323232\
X0xXX5555 CLIENT $125.50 (Credit Mar 1, 2019 121212 12222222222

X12 835 Extended PDF

Remittance Advice Report

ACH Information

Receiver Name: Bob's Grocery Originator Name: CAT HC PDX TEST
Settiement Date: Oct 10, 2019 Effective Entry Date: 191010

DFI Account Number: 10001525 Trace Number: 255076920009633
Amount: $100.00 SEC Code: CCD

Transaction Type: 22 Transaction Description: HCCLAIMPMT

Remittance Information

Reassociation Trace Number 121212
Originating Company Id 5555555555
Reference Number 123456789\

9. XIl2 835 Default CSV

] A B 4 o E F [ H T i) K L ™

| Receiver Name Receiver Account ® Originator Name Originator 1D Entry Descripticn Transaction Amount Debit or Credit Effective Date Date ACH Trace Number | Trace Number Originating Comparty Identifier Reference Number
umt 1 onxassss POX TESTCUENT 2222222222 WCCLAIMPMT 125.5 Credit 2/28/2m9 222019 EANE510001538 121212 2 1BBn

unt2 xxxnb666 POX TESTCUENT 2222222222 WCCLAIMPMT 225.5 Debit /9 28/2015  GANES10001539 134343 2222220222 1454545454\

wnt3 77T PDX TEST CUENT HCCLAIMPMT 325.5 Credit 2/28/2015 222015 GANES10001540 156565

10. X12 CCD+ 835

S5200CAT HC PDX TEST 5555555555CCDHCCLAIMPMT 191010 1255076920000001
62225507€92810001525 0000010000€56561 Bob's Grocery 1255076920009633
TRN*1*121212*5555555555%123456789\
€2225507€92810001555 0000030000&5€51 ABC Heating 1255076920009635
TRN*1%565656*5555555555%123456789\

I'l. X12 835 Raw Text File

| EDI_Data_184_2019-03-01.txt - Notepad

File Edit Format View Help

[TRN*1%121212%2222222222%1232323232\
TRN*1%134343%2222222222%1454545454"
TRN*1%156565%2222222222%1676767676),

12. Free Form PDF

Addenda Report

Generated Mar 1, 2019 8:28:39 AM

Account Name SLERoU Originator Name l Amount Seuinent Addenda
Number | | ' Date
Account 1 xxxx5555 PDX TEST CLIENT | $25.50 | Mar 1, 2019 ACH Alert 00001

13. Free Form Raw Text File
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| EDI_Data_186_2019-03-01.txt - Notepad

File Edit Format View Help

ACH Alert 00001
ACH Alert 00002
ACH Alert 00003

14. Free Form Extended PDF

Remittance Advice Report

ACH Information

Receiver Name: Bob's Grocery Originator Name: CAT FF PDX TEST
Settlement Date: Oct 10, 2019 Effective Entry Date: 191010

DFI Account Number: 10001525 Trace Number: 255076920009627
Amount: $125.50 SEC Code: CCD

Transaction Type: 22 Transaction Description: FREEFORM

Remittance Information

[Payment for bulk banannas

Transaction History

View Transaction History

I. Switch to the EDI TransAlert Module by clicking on EDI TransAlert on the Dashboard or from the Change Module
dropdown menu.

Total with Addenda $0.00 ©  Total without Addenda $0.00 [ 0]
Credits $0.00 0O credits $0.00 (0]
Debits $0.00 (0] Debits $0.00 [ 0]
Invalid Addenda $0.00 (0]

Change Module ~

PRO-CHEX
PRO-TECH CR
PRO-TECH
BIO-WIRE
C.0.P.S.

EDI TransAlert

2. Click Transaction History.



. . Date Range
Transaction History i g_
WMarch 29, 2019~
Y Filters >
IDI: Account Account Name Originating Company Credit Debit Settlement Date View
> 974 XX 1555 ABC Heating CAT HC PDX TEST $300.00 03/29/2019 ®
> 973 Xxxx2345 Billy's Towing CAT HC PDX TEST $200.00 03/29/2019 >
> 972 Wxx1525 Bob's Grocery CAT HC PDX TEST $100.00 03/29/2019 @
> N 00001555 ABC Heating CAT CTX PDX TEST $16.122.80 03/29/2019 ®
> 970 Xxx2345 Billy’s Towing CAT CTX PDX TEST $40,559.00 03/29/2019 @
> 969 XoX1525 Bob’'s Grocery CAT CTX PDX TEST $3.555.00 03/29/2019 @
> 968 00001555 ABC Heating CAT FF PDX TEST £40.00 03/29/2019
> 967 KK 2345 Billy's Towing CAT FF PDX TEST $60.00 03/29/2019
> 966 wox 1525 Bob's Grocery CAT FF PDX TEST $50.00 03/29/2019
> 965 001555 ABC Heating CAT FF PDX TEST $325.55 03/29/2019 <]
> 964 o 2345 Billy's Towing CAT FF PDX TEST $225.25 03/29/2019 ]
> 963 001525 Bob's Grocery CAT FF PDX TEST $125.50 03/29/2019 @
Field Description |
= The Transaction ID is unique to POX and is assigned to the transaction when it is
Transaction loaded.
ID = Select Transaction ID to sort from A-Z. Select the Transaction ID again to sort
from Z-A.
®* The Account#
Account# .
= Select Account# to sort from A-Z. Select Account# again to sort from Z-A.
Account = Name of the account the transaction came in on
Name
Originating = The Company that sent the transaction.
Company = Select Client to sort from A-Z. Select Client again to sort from Z-A.
. . = The dollar amount of the transaction.
Credit/Debit ) . .
= Select Client to sort from A-Z. Select Client again to sort from Z-A.
= The settlement date of thetransaction.
Settlement .
Date = Select Settlement Date to sort form A-Z. Select Settlement Date again to sort from
Z-A.
View = Used to view the addenda information for the transaction.

3. Date Range can be selected to search for a specific Date or Date Range.

; 5 Date Range
Transaction History e
#EMarch 29, 2019~
Y Filters Tomorrow
Yesterday
IDIE Account Account Name Originating Company Credit Debit Settleme SRR
F . Last 7 Days
» 974 20001555 ABC Heating CAT HC PDX TEST 5300.00 03/29/20
This Manth
> 973 206xx2345 Billy's Towing CAT HC PDX TEST $200.00 03/29/20
Last Month
? 972 xxxx1525 Bob’s Grocery CAT HC PDX TEST $100.00 03/29/20

Custom Range
> 9N Xx¥xx1555 ABC Heating CAT CTX PDX TEST $16,122.80 03/29/20

Cancel
> 970 XXNK2345 Billy's Towing CAT CTXPDXTEST $40,559.00 03/29/20._ =

> 9689 HXXK1525 Bob's Grocery CAT CTX PDX TEST $3.555.00 03/29/2019 @




Option Results

Tomorrow Will display the transactions for the next business day.
Today Will display the transactions for today.
Yesterday Will display the transactions from the previous business day.
Last 7 Days Will display the returned items for the last 7 business days.
This Month Will display the transactions for the current month.
Last Month Will display the transactions for the previous month.
Custom Range = Will display the transactions during the date range.

= Select Apply to display the custom date range of transactions.

4. Click Filters to customize the search options.

Y Filters

. Transaction Type EDI Type
Account’ yP i

Both v All Types v

ypPes

- not selected - v
Min Amount Max Amount

3 $

|

Option Results

Account As you start typing Account names and/or numbers that match will appear.
Number

Transaction Select Both, Credit or Debit.

Type

Enter a minimum dollar amount to search for transactions with at least this
dollar amount or more.

Search by transaction type by selecting All Types, 820 EDI Information,
EDI Type 835 Healthcare Payments, Free Form Addenda, No Addenda or With
Addenda.

Enter a maximum dollar amount to search for transactions with this

amount or less.

Min Amount

Max Amount

5. Select Apply to display the transactions with the selected filters.

6. Select the arrow(>) next to any transaction to display additional information for the transaction.

ID‘H Aroount s ¢ oepnt Naime Owrlgpinating Company Creddif D Settiermeent Date

v o7 0001555 ABC Heating CAT HE PO TEST $300 03/F2019
ACcount ABC Heating (xox1555) SEC Code: CCO Trace & 255076820001923
DLFI Routing Number: 064202471 Descripthon: HOCLATMPMT Compary [0 5555555555

aregaction 10: 974
Indhvidual Marme: ABC Heating

Optio Re

Account Account Name for the Client

ODFI Routing The routing number of the originating depository financial institution

Number




Transaction ID Unique system identifier for transaction
Individual Name Individual Name for the transaction

SEC Code SEC Code for the transaction

Description Description information for the transaction
Trace# Trace Number for the transaction

Company ID Company ID of the Originator of the transaction

7. To view addenda information for a transaction, click the eye icon under View.

EDI Data for Account: 77777, Trace Number: 064208510001498

I5A=00* *00% *ZZ*DOGGY-DOGS TOYS*ZZ*KITTY COMPANYS *181231%104
4%U*00400%646464646*0%P*~\GS*RA*DOGGY-DOGS TOYS*KITTY COMPANYS*20181231%1044+644
555555*X*004010\ST*820*0001\BPR*C*16122. 80*D¥ACH*CTX*****5858585858 \TRN*1*002000
1523\ENT*1\RMR*ZZ*Q37373737+*16122.80\REF~L1*#1 959595959 373737-01 KITTY COMPAN
YS - staff\SE*7*0001\GE*1*644444444\IEA* 17644444444,

Download Clase

8. To download the individual addenda record, click download on the pop-up screen.

File Export Status

View File Export Status

I. Switch to the EDI TransAlert Module clicking on EDI TransAlert on the Dashboard or from the Change Module
dropdown menu.

EDI TransAlert

Total with Addenda $0.00 L 0] Total without Addenda $0.00 o
Credits $0.00 [0] Credits $0.00 (0]
Debits [0] Debits $0.00 (0]
Invalid Addenda $0.00 (0]

Change Module ~

PRO-CHEX
PRO-TECH CR
PRO-TECH
BIO-WIRE
C.0.P.S.

EDI TransAlert

2. Click EDI TransAlert > View and Export Status.

EDI TransAlert £ Manage ~ = Transaction History ol View ~

Export Status




Date Range
Export Status
@|May 22, 2019~
Y Filters >
(ir-nn‘r,lr'mr_fl[u-r h‘l-pn(t Name h‘a-'mrt Status I!r-:!m--.lml Date/Time
» SYSTEM 0001_10001555 _820_EDI_Data_659_2019-05-22.pdf GENERATED Wed, 22 May 2019 09:45:00
» SYSTEM 0001_10002345 _EDI_Data_658_2019-05-22.txt GENERATED Wed, 22 May 2019 09:45:00
» SYSTEM 0001_10001525 _835_EDI_Data_657_2019-05-22.pdf GENERATED Wed, 22 May 2019 09:45:00

Option Results

. = System — Generated by the FI
Generating User o
= Username — Individual user

Report Name = System generated report name

= Failed — report did not generate
Report Status = Generated — report was generated but not downloaded
*= Downloaded — report was downloaded

Requested Date/Time * When the report was generated by the user.

3. Date Range can be selected to search for a specific Date or Date Range.

Date R
Export Status i

EMay 22, 2019~

Y Filters Tomarrow

Generating User Report Name Report Status Request Yesterday

> SYSTEM 0001_10001555 _820_EDI_Data_659_2019-05-22.pdlf GENERATED Wed,22 Last7Days

> SYSTEM 0001_10002345 _EDI_Data_658_2019-05-22.txt GENERATED Wed,22 T

> SYSTEM 0001_10001525 _835_EDI_Data_657_2019-05-22.pdlf GENERATED Wedizy] SRS

> SYSTEM 000110002345 _EDI_Data_656_2019-05-22.txt GENERATED Wed 22| CUSomRange

> SYSTEM 0001_10001525 _820_EDI_Data_655_2019-05-22.c5v GENERATED Wed, 22 m i
> SYSTEM 0001_10001555 _EDI_Data_654_2019-05-22.txt GENERATED Wed, 22 May 2019 09:45:00

Option Results

Tomorrow Will display the transactions for the next business day.

Today Will display the transactions for today.

Yesterday Will display the transactions from the previous business day.
Last 7 Days Will display the returned items for the last 7 business days.

This Month Will display the transactions for the current month.

Last Month Will display the transactions for the previous month.

Custom = Will display the transactions during the date range.

Range = Select Apply to display the custom date range of transactions.

4. Click Filters to customize the search options.

T Filters

Record Type Report Status

--58

ct record type - Y A ¥




Option Results

Search by transaction type by selecting 820 EDI Information, 835 Healthcare

Record Type Payments, Free Form Addenda.

Report Status Search by Report Status type by selecting All, Downloaded, Failed or Generated.

Select Apply to display the transactions with the selected filters.

Select the arrow(>) next to any transaction to display additional information for the transaction.

Export Status Eate_Range
EWMay 22, 2019+
Y Filters >
Generating User Report Name Report Status Requested Date/Time
v SYSTEM 0001_10001555 _820_EDI_Data_659_2019-05-22.pdf GENERATED Wed, 22 May 2019 09:45:00
Generated Date: Wed, 22 May 2019 09:45:04 Download Report

Option Results

Generated Date Date the report was generated.
Downloaded Date Date the report was downloaded.
Download Report Ability to redownload the report.
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